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14.0 Using References

Elements in a reference file display as though they are geometry in the active design file. Although you cannot manipulate or delete the elements displayed in a reference file, you can snap to them and even copy them into the active design file.

The most common usage of references is in the creation of design compositions. Engineers and other technical professionals use design compositions to communicate through the visual content of their designs.

To create a design composition using MicroStation, you build a design file consisting of a working collection of references used in the performance of particular engineering tasks. For example, you may attach as references a collection of survey points as a guide for placement of additional geometry.

· It is sometimes convenient to refer to one part of a design file while drawing in another area by attaching the active design file to itself.

14.1 References dialog box

Used to attach and detach referenced models, adjust reference settings and select reference tools. Opens when the Reference icon is selected in the Primary Tools toolbox or when File > Reference is chosen.
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Show Hierarchy
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When on, displays a tree that shows the active file and references that are directly attached to it. References that have other references attached to them (nested references) are listed in black text, and references that do not have attached references are listed in gray text.


If a reference in the hierarchy has a nest depth value of 1 or more, you can: 

· Click on the (+) sign and expand the hierarchy display.

· Select the reference. When you do this, the References list box updates to include only the references that are attached to the selected reference.

When the tree is turned off, you can use the arrow button next to the Show Hierarchy icon to list the active file and any references that are directly attached to it. As in the tree, if you choose a reference that has attached references, the References list box updates to include only the references that are attached to the selected reference.

Reference tool box

Contains tools used to:
· Access the References dialog.
· Attach referenced models to the active model.
· Control the positioning, scaling, clipping, and orientation of attached referenced models.
· Detach referenced models from the active model.
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These tools can also be selected in these ways:

· From the icons on the References dialog (File > Reference). 
· From the Tools menu in the References dialog (File > Reference). The controls in the References dialog are used to adjust reference settings as well.

All tools in a toolbox are not always visible by default. To see all tools, right-click in the toolbox and select Show All from the menu.


	To
	Select in the Reference toolbox

	Manage reference attachments using the References dialog.
The References tool is also found on the Primary Tools toolbox.
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References

	Attach a model (reference) to the active model.
	[image: ]
Attach Reference

	Change a reference clipping boundary.
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Set Reference Clip Boundary

	Mask (cover) part of a reference that is inside the clipping boundary.
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Set Reference Clip Mask

	Selectively delete a reference's clipping mask(s).
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Delete Reference Clip

	
Set the back clipping plane for a 3D reference.
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Set Reference Back Clip Plane

	Set the front clipping plane for a 3D reference. 
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Set Reference Front Clip Plane

	Reread and redraw a reference to see recent changes made to it.
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Reload Reference

	Move a reference.
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Move Reference

	Copy a reference.
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Copy References

	Scale a reference.
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Scale References

	Rotate a reference.
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Rotate Reference

	Mirror a reference about a horizontal or vertical axis.
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Mirror Reference

	Copy a reference, then attach a view of the reference by folding it about an orthogonal axis or a line defined by two points.
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Copy Reference by Folding

	Sets the rendering mode of the reference.
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Set Reference Presentation

	Detach a reference from the active model.
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Detach Reference




Hilite Mode	[image: ]

Controls whether the selected references are highlighted and surrounded by a border.

· None — Selected references are not highlighted in any way.
· Boundaries — Places a dashed border around selected references.
· Hilite — Highlights selected references.
· Both — Places a dashed border and highlights selected references.


Located along the bottom of the References dialog box are additional icons that control the attachment settings for the different reference files.
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Displays and controls settings for a selected reference. 

· Scale — Displays and sets the ratio of master units in the active model to the master units in the attached model.
· Rotation — Displays and sets the rotation for the selected reference. For 2D files, you can enter the rotation angle for the z-axis only. In 3D, you can enter the rotation angles for the x-, y- and z-axes.
· Offset — Displays and sets the distance between the global origin of the reference from the global origin of the parent file, measured in units of the parent file. If the parent is 2D, Offset X and Y values are displayed. If the parent is 3D, Offset X, Y, and Z values are displayed. 
· Attachment settings icons — The information panel icons correspond to columns in the References list box, as well as to icons on the Reference Attachment Settings dialog. 

If an icon is pressed, the setting is on. Click the icons to toggle the settings on or off. For more information on an icon, see the description for the corresponding column in the References list box.

If you select multiple references that have different settings, the icons representing different settings are shaded. For example, if one of the selected references has True Scale enabled while the other selected reference has True Scale disabled, the True Scale icon is shaded. 

· Nesting menu — Displays and sets how nested references (references attached to references) are handled for the selected attachments. 
· 
	Menu Item
	Description

	No Nesting
	Nested references are ignored for this attachment.

	Live Nesting
	The hierarchical structure of any nested references are maintained when attaching the reference. The child references are displayed if:
the nest Depth is set high enough
the child reference does not have its Ignore Attachment When Live Nesting setting turned on
All of the nested attachments display in the view window; however you see only the parent reference in the References list box. To see the hierarchy of nested references, use the Show Hierarchy icon on the References dialog.

	Copy Attachments
	Models that are attached to the attached model are copied (referenced) directly into the active model, which flattens the hierarchical structure of the nested references. 



— Note: When working in a DWG or DXF file, live nesting is always on, and there is no limit to nest depth. Therefore the nested attachment and Depth items are disabled. To control the display of nested attachments, use the Ignore Attachment When Live Nesting icon.

· Overrides menu — Controls how override settings are saved for nested references. For a specific nested reference, overrides let you control the settings for reference display, locate, snap, raster reference display, and level display. 

	Menu Item
	Description

	Allow Overrides
	The overrides are automatically created as required when you modify the corresponding settings for nested references.
Key-in: reference set nestOverrides=allow

	Always Override
	Saves the toggle and level display state for every nested attachment. This option locks in the settings for all nested attachments. The settings change only if you specifically change them.
Key-in: reference set nestOverrides=always

	Never Override
	Never creates overrides for any of the nested references. The nested references are displayed the same as they are when the reference is opened as the master file.
Key-in: reference set nestOverrides=never



· Depth — Sets the number of levels of nested references that are displayed. Models can have their own referenced models, which, in turn, can have more referenced models, and so on. 

If Depth is set to 0, only the selected model is attached to the master model; models referenced to the selected model are ignored. 

When working in a DWG or DXF file, live nesting is always on, and there is no limit to nest depth. Therefore the Nested Attachments and Depth items are disabled. To control the display of nested attachments, you must open the reference as the active model, and use the Ignore Attachment When Live Nesting setting for its attachments. 

· New Level Display — Specifies whether a reference displays new levels. The setting also applies to new levels in nested references that are attached to the reference. 

	Menu Item
	Description

	Config Variable
	New levels in the reference are displayed according to the setting for the MS_REF_NEWLEVELDISPLAY configuration variable.

	Always
	New levels in the reference are always displayed.

	Never
	New levels in the reference are never displayed.



· Georeferenced — Sets the georeference mode. When a reference is attached in Reprojected mode, the current Reference Reprojection Settings are copied into the reference attachment and stored so every user who opens the master file uses the same reprojection settings and thus, gets the same results.

· path — Shows the full specification for the reference, including the directory.

· Right-click menu — Controls the display of items in the information panel.




14.2 Attach Reference	[image: ]

Opens the Attach Reference dialog, which is used to attach one or more models to the active model. 
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1. In the Primary Tools toolbox, click the References icon.
[bookmark: P229E3]
2. In the References dialog, click the Attach Reference icon.
[bookmark: P229E4]
3. [bookmark: P243FF]In the Attach Reference dialog, select the DGN file that contains the model to attach as a reference.

4. From the Attachment Method option menu, choose Coincident World (Coincident World — Aligns the references with the active model with regard to both Global Origin and design plane coordinates). This is the preferred method at moDOT.
[bookmark: P24400]
5. Click OK.
[bookmark: P229E5]
6. In the Reference Attachment Settings dialog, adjust settings as required.

7. Make sure “Save Relative Path” is checked (Save Relative Path allows MicroStation to search backwards through the directory structure for reference files).
[bookmark: P229E6]
8. Click OK. 






14.3	Locating “lost” attachments

If MicroStation cannot locate a reference upon opening a DGN file, the geometry for that file will not be displayed in the active file. Upon opening the Reference dialog box, “lost” reference files will be listed in red instead of the black color that represents a correctly attached file.
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Reattaching a “lost” file

1) Double-click on the listing for the lost reference file within the Reference dialog box.

The attachment Settings		[image: ]
dialog box appears.

Notice that no path is listed
next to the Full Path portion
of the dialog. Also make note
of the file name that needs to
be attached so that this exact
file can be located.

2) Since the path for this file has
been lost, it will need to be
located manually. Within the
Attachment Settings dialog
box click the Browse button.

The Reattach Reference dialog box appears.

[image: ]
3) The Reattach Reference dialog box will default to the home directory of the active file that you are working in, so you may have to navigate to the directory where the reference file is located.

4) Once you are within the correct directory, navigate through the Files listing until you find the correct file name to attach.

Be careful you have the correct file name ! MicroStation will attach any file that you  specify at this point, so choosing the wrong file will result in geometry that is incorrect for the active file.

If necessary, you can grab the Reattach Reference dialog box by the banner and move it so that you can see the file name in the Attachment Settings dialog box.

5) Make sure the Save Relative Path setting is checked in the lower left corner of the dialog box.

6) Select the desired file for attachment by highlighting the name in the list and hitting Enter on your keyboard or the OK button on the dialog box, or by double-left-clicking the name within the listing.

7) Once the file has been selected from the Reattach Reference dialog box, you will notice that the full path portion of the Attachment Settings dialog box is now populated with the correct directory path and file name. Click the OK button on the Attachment Settings dialog box.

You will notice now that the listing for the reference file is now shown in black and that the geometry for that file is now displayed in the active file.



[image: ][image: ]14.4	Identifying References		




Identifying references on which to operate is an alternative to selecting the reference in the References dialog box’s list box; the identification technique is typically used with the tools in the References tool box.

To identify a reference

In a view window, identify an element in the reference with a single data point click.  The reference information will be displayed with-in the Message Center of the Status bar.
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14.5	Set Reference Clip Boundary

[image: ]
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Used to define a reference 
clipping boundary.						


	Tool Settings
	Effect

	Method:
	Determines the method by which the reference clip boundary is set.
· Active Fence — Uses the active fence as the clip boundary.
· Element — Uses an element or cell to set the clip boundary.
· Named Fence — Uses a named fence to set the clip boundary.

	Discard Existing Clip Masks
	If on, deletes existing clip masks before applying a new clipping boundary.

	Use Reference Dialog List
	If on, the clip boundary applies to the references selected in the References dialog. If off, you are prompted to select the references to be clipped.



For example:

[image: ]
 (
Here we have too much roadway for our plan view.
)
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Using the Level Display dialog, we can turn on
the appropriate level with the element boundary	
showing the plan view. With this boundary
displayed we can place a fence on that element.










	[image: ]							
At this point we can
								choose the Reference
								Clip Boundary tool to
								initiate the clip. Now
								simply left-click in the
								view to accept the clip.
								This will clip off the
								excess roadway.




14.6	Set Reference Clip Mask

[image: ]


[image: ]Used to place a reference clipping 
mask defined by an active fence.



	Tool Settings
	Effect

	Use Reference Dialog List
	If on, the clip mask applies to the models selected on the References dialog. If off, you are prompted to select the models to be clipped.


14.7 Delete Reference Clip Mask

[image: ]

Used to selectively delete clipping masks or clip boundaries.

	Tool Settings
	Effect

	Use Reference Dialog List
	If on, clipping is deleted in the models selected on the References dialog.

	Use Fence
	If on, the fence contents are deleted from the reference clipping. The option menu sets the Fence (Selection) Mode.



[image: ]

To selectively delete reference clipping

1) In the References dialog, select the references that have clipping to delete.
[bookmark: P1BC58]
2) Click the Delete Clip icon.
The Delete Reference Clip tool settings window opens.
[bookmark: P1BC7A]
3) Turn on Use References Dialog List.
The clip boundary and any clip masks within the boundary highlight.
[bookmark: P1BC5A]
4) Identify the clip boundary, or clipping mask to be deleted.
[bookmark: P1BC5B]
5) Accept the deletion.
or
Reset to keep the highlighted clip boundary or clipping mask.
[bookmark: P1BC5C]
6) Repeat step 4 for each subsequent clipping mask.

· When you select a reference (or have one selected from the selection set, fence or dialog), the reference is highlighted. If there is a clip boundary and one or more masks, the boundary is shown in yellow and the masks shown in red.










14.8 Reload Reference

[image: ]When working with models that include references, it is possible that other users are making changes to the references. When a change has been made to a reference, and it has not been updated in the active model, the references dialog displays an icon in the Status column for the reference. This indicates that you need to reload the reference in the current session to get the latest updates.

















To reload a reference

1) In the list box in the References dialog, select the reference.
[bookmark: P1BC2E]
2) Click the Reload Reference icon.
The reference is redrawn. 

· Reloading a reference lets you see changes that have been made to the reference by a co-worker on the network since the reference was last attached or reloaded.

To reload all attached references

1) From the Tools menu, choose Reload All. 
The references are redrawn.














14.9 Move Reference File

[image: ]

[image: ]Used to move a referenced design file.	




	Tool Settings
	Effect

	Move Boundary with Reference
	If on, any clipping boundary and/or clipping mask(s) is moved with the reference.
If off, the reference is moved, with any clipping boundary and/or clipping mask(s) remaining as is. In effect, the reference “slides” through the boundaries/masks.

	Use Reference Dialog List
	If on, the models selected on the References dialog are moved. 

	Use Fence
	If on, the fence contents are moved. The option menu sets the Fence (Selection) Mode



To move a reference selected from the References dialog list

2) In the References dialog's list box, select the references that you want to move in the active model.
[bookmark: P24419]
3) Turn on Display, Snap, and Locate.
[bookmark: P2441A]
4) Click the Move References icon in the References dialog.
[bookmark: P2441B]
5) In the tool settings window, turn on Use References Dialog List.
[bookmark: P2441C]
6) Enter a data point to begin the move, and drag the reference to the desired location.

To move a reference using a fence

1) Place a fence around the area containing the references to be moved. 
[bookmark: P24420]
2) In the References dialog's list box, select a reference.
[bookmark: P24421]
3) Click the Move References icon.
[bookmark: P24422]
4) In the tool settings window, turn off Use References Dialog List.
[bookmark: P24423]
5) Turn on Use Fence and choose the fence mode. 
[bookmark: P24424]
6) Enter a data point to begin the move, and drag the fence and reference to the desired location. 


14.10 Copy Reference File

[image: ]
[image: ]
Used to copy attached references.	



	Tool Settings
	Effect

	Copies
	Set the number of copies to make.

	Move Boundary with Reference
	If on, any clipping boundary and/or clipping mask(s) is copied along with the reference.
If off, only the reference is copied, while any clipping boundary and/or clipping mask(s) is ignored.

	Use Reference Dialog List
	If on, the models selected on the References dialog are copied.

	Use Fence
	If on, the fence's contents are copied. The option menu sets the Fence (Selection) Mode.



To copy elements from a reference to the active DGN file

1) In the References dialog's list box, select the reference in which the elements are located.
[bookmark: P24427]
2) Turn on Display, Snap, and Locate.
[bookmark: P24428]
3) Select or place a fence around the elements to be copied.
[bookmark: P24429]
4) From the Manipulate toolbox, select the Copy tool.

To copy references selected from the References dialog list

1) In the References dialog's list box, select the references that you want to copy in the active model.
[bookmark: P2442F]
2) Turn on Display, Snap, and Locate.
[bookmark: P24430]
3) Click the Copy References icon.
[bookmark: P24431]
4) In the tool settings window, turn on Use References Dialog List.
[bookmark: P24432]
5) (Optional) To make multiple copies, turn on Copies and in the adjacent field, key in the number of copies.
[bookmark: P24433]
6) Enter a data point to begin the copy. 
[bookmark: P24434]
7) Drag the reference to the desired location, and enter a data point to place the copied model.
To copy references using a fence

1) Place a fence around the area containing the references to be copied. 
[bookmark: P24438]
2) In the References dialog's list box, select a reference.
[bookmark: P24439]
3) Click the Copy References icon.
[bookmark: P2443A]
4) In the tool settings window, turn off Use References Dialog List.
[bookmark: P2443B]
5) Turn on Use Fence and choose the fence mode.
[bookmark: P2443C]
6) (Optional) To make multiple copies, turn on Copies and in the adjacent field, type in the number of copies.
[bookmark: P2443D]
7) Enter a data point to begin the copy.
[bookmark: P2443E]
8) Drag the reference to the desired location, and enter a data point to place the copied model.

14.11 Scale References

[image: ]
[image: ]

Used to resize a referenced design file.					[image: ]



	Tool Settings
	Effect

	Method
	Method by which the referenced model is scaled.
· Scale Factor — Reference is scaled by a specified factor. For example, a scale factor of 2.00000 doubles the size of the reference.
· Absolute Ratio — Reference is scaled by a specified ratio of Master file units to Reference file units. For example, to set five active model master units for each referenced model master unit, key in 5 in the left-hand field and 1 in the right-hand field.
· By Points — Model is scaled by points entered.

	Move Boundary with Reference
	If on, any clipping boundary and/or clipping mask(s) is scaled along with the reference.
If off, only the reference is scaled, while any clipping boundary and/or clipping mask(s) remain as is.

	Use Reference Dialog List
	If on, the reference(s) selected in the References dialog is scaled.

	Use Fence
	(Fence present only) If on, the fence contents are scaled. The option menu sets the Fence (Selection) Mode.



To scale references selected from the References dialog list

1. [bookmark: P24440]In the References dialog's list box, select the references that you want to scale in the active model.

2. Turn on Display, Snap, and Locate.

3. Click the Scale References icon.

4. In the tool settings window, choose the scaling Method (and key in the scale factor or ratio, if applicable).

5. Turn on Use References Dialog List. 

6. Enter a data point about which the reference is scaled.

To scale references selected using a fence

1. Place a fence around the area containing the references to be scaled. 
[bookmark: P24449]
2. In the References dialog's list box, select a reference.
[bookmark: P2444A]
3. Click the Scale References icon.
[bookmark: P2444B]
4. In the tool settings window, choose the scaling Method (and key in the scale factor or ratio, if applicable).
[bookmark: P2444C]
5. Turn off Use References Dialog List.
[bookmark: P2444D]
6. Turn on Use Fence and choose the fence mode. 
[bookmark: P2444E]
7. Enter a data point about which the references are scaled.

14.12 Rotate References

[image: ]
In the References dialog's list box, select the references that you want to scale in the active model.
[bookmark: P24441]
Turn on Display, Snap, and Locate.
[bookmark: P24442]
Click the Scale References icon.
[bookmark: P24443]
In the tool settings window, choose the scaling Method (and key in the scale factor or ratio, if applicable).
[bookmark: P24444]
Turn on Use References Dialog List. 
[bookmark: P24445]
Enter a data point about which the reference is scaled. 

[image: ]
[image: ]Used to rotate a reference.	


									



	Tool Settings
	Effect

	Method
	Sets the method by which the reference is rotated.
· By Angles — Sets the rotation angle(s). In 2D, sets the rotation angle(s) on the z-axis only. In 3D, sets the rotation angle(s) on the x-, y-, and z axes.
· By Points — Sets the point about which the reference is rotated.

	X
	Angle to rotate the reference about the x axis for 3D files.

	Y
	Angle to rotate the reference about the y axis for 3D files.

	Z
	Angle to rotate the reference about the z axis for both 2D and 3D files.

	Move Boundary with Reference
	If on, any clipping boundary and/or clipping mask(s) is rotated with the reference.
If off, only the reference is rotated, with any clipping boundary and/or clipping mask(s) remaining as is.

	Use Reference Dialog List
	If on, the model(s) selected in the References dialog is rotated.

	Use Fence
	If on, the fence contents are rotated. The option menu sets the Fence (Selection) Mode.



To rotate references selected from the References dialog list

1. In the References dialog's list box, select the references that you want to rotate in the active model.
[bookmark: P24451]
2. Turn on Display, Snap, and Locate.
[bookmark: P24452]
3. Click the Rotate References icon.
[bookmark: P24453]
4. In the tool settings window, choose the rotate Method (and key in X, Y, Z coordinates if method is By Angles).
[bookmark: P24454]
5. Turn on Use References Dialog List. 
[bookmark: P24455]
6. Enter a data point about which the references are rotated.

To rotate references using a fence

1. Place a fence around the area containing the references to be rotated.
[bookmark: P24459]
2. In the References dialog's list box, select a reference.
[bookmark: P2445A]
3. Click the Rotate References icon.
[bookmark: P2445B]
4. In the tool settings window, choose a rotate Method (and key in X, Y, Z coordinates if Method is By Angle).
[bookmark: P2445C]
5. Turn off Use References Dialog List.
[bookmark: P2445D]
6. Turn on Use Fence and choose the fence mode.
[bookmark: P2445E]
7. Enter a data point about which the references are rotated.

14.13 Detach Reference

[image: ]


Used to detach a referenced design file from the active design file.

[image: ]

	Tool Settings
	Effect

	Use Reference Dialog List
	If on, the reference(s) selected in the References dialog is detached from the master file.

	Use Fence
	If on, the references contained by the fence are detached from the active model. The option menu sets the Fence (Selection) Mode



To detach references

1. In the References dialog's list box, select the references.
[bookmark: P1BC37]
2. Click the Detach Reference icon.
An alert box asks you to confirm that the selected references are to be detached.
[bookmark: P1BC38]
3. Click OK.

To detach all references

1. From the Tools menu, choose Detach All.
An alert box asks you to confirm that all references are to be detached.
[bookmark: P1BC3B]
2. Click OK.
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